lesson 5 INTE 290
Office 2007 Applications
 
Microsoft Office 2007 is a combination of four software applications. You will select the software that is appropriate for the task you are trying to accomplish, so you should begin each project by thinking about what the output will be.
	Word
	 Document processing

	 Excel
	 Spreadsheet

	 PowerPoint
	 Presentation

	 Access
	 Database


Word is used for document processing such as letters, memos, resumes and reports. Word focuses on manipulating text to create, edit and format documents. 
Excel stores numeric data and performs calculations on this data. It can also create charts for a graphic view of the data. Spreadsheets are used to create budgets, project payments for a mortgage or loan, and to analyze statistical information.
PowerPoint is a presentation software package. Presentations can be given by speakers, they can be self-presenting like those you might see in a kiosk, or they can consist of a web page presentation.
Access is a relational database which stores data and converts it into information. It is used mainly for decision making in the business world because it is so easy to compile data into informative reports. Access will not be covered in this course.
One of the advantages of Office is that the applications work together and complex projects can be completed by integrating the applications. Another advantage is that many tasks are accomplished in exactly the same way in all of the applications. This makes them easier to learn and to use.
Common Interface Components
 
		· Office Button
· Office Menu
· Quick Access Toolbar
· Title Bar
· Status Bar
	· Ribbon
· Tabs
· Groups
· Commands



	


If you have used previous versions of Office, the tools available in Office 2007 will be familiar in concept, but they may be located in different places and use different icons to represent the command. The following slides will discuss not only the similarities in the software, but also the location and concept behind the commands.
A user interface is the meeting point between the computer and the person using it. The Microsoft Office 2007 software program is the user interface. There are many commonalities between its four different applications.
The most noticeable components that are common are at the top and bottom of the software windows. The Office Button displays the Office Menu which contains the same commands in each software application. The Quick Access Toolbar provides icons for normal tasks. The title bar helps you to identify the file you are working on and the application. The Ribbon displays commands in groups on tabs. The Status Bar provides useful information about the file you are working on in the window.
Each of these interface components will be discussed in detail in the following slides
Common Interface Components (cont'd) 
[image: common interface]
 
The Office Button holds the Office menu which contains commands that work on the entire file or program. Common commands on this menu include ways to save, print and share the file. You will also find options to change the properties of the software application, or to exit the application.
The Quick Access toolbar contains buttons for frequently used commands such as saving a file, undoing the last action or refreshing the screen. This toolbar keeps these commands readily available at all times. An advantage of this toolbar is that it can be customized by adding buttons or removing those that are not used. If you wish, you may also change the location of this toolbar by dragging it below the Ribbon.
The title bar lists the filename of the document and the Office 2007 application you are using. In the file shown here, the filename is Document 1, and the application is Microsoft Word. The title bar also contains the commands to minimize, maximize and close the application as it does in all Windows applications.
The Ribbon
[image: the ribbon]
The Ribbon holds visual commands arranged on tabs. This is the command center of the Microsoft Office 2007 software. There are three components on the Ribbon: tabs, groups and commands.
The tabs, which look like file folder tabs, are divided into task-related sections. In this graphic from PowerPoint you can see tabs for Home, Insert, Design, Animations, Slide Show, Review, View and Add-ons. The active tab is the Home tab, meaning that the commands shown are the core commands for the application program.
The core commands are grouped. These are related commands that are put together so you can find them quickly. On the Home tab, you see groups of commands for the Clipboard, Slides, Font, Paragraph, Drawing and Editing. When you click on another tab, you will see different command groups.
The Commands are the specific tasks to be performed. They are visual icons or buttons in the grouping. The icons give you a visual clue. Look at the Shapes command in the Drawing group. There are a few shapes there. Look at the Find command in the Editing group. It is a pair of binoculars for finding things!
The Ribbon (cont'd)
[image: the ribbon continued1]
This is the Ribbon with the Home tab displayed from Word. In Word you have different interface needs. Most often, you will be using commands that allow you to format the text and manipulate it by copying and pasting it.
Also note that the Word and PowerPoint tabs are different. The Word Ribbon contains the tabs Home, Insert, Page Layout, References, Mailing, Review and View. You will remember that the PowerPoint Ribbon contained the tabs Home, Insert, Design, Animations, Slide Show, Review, View and Add-ons. Different software have different requirements and the tabs reflect these differences.
If you do not want to see the Ribbon in any application, it can be made smaller by double-clicking on the active tab. This hides the groups and commands. When you want to display the entire Ribbon again, click the active tab.
The Ribbon (cont'd)
[image: the ribbon continued2]
The Ribbon also contains other components that will make your work easier. The Dialog Box Launcher is a small icon, usually an arrow, which opens a dialog box with a related group of commands.
The Gallery is a set of options that appear as thumbnail graphics to represent the results. You can see the Font Gallery with the Bold icon being bold face, the Italic icon being an italic face, and the Underscore icon being underscored.
The Live Preview works with galleries to show you a preview of how the document would look with the formatting commands applied. This saves you time, because you can instantly see if the formatting serves your needs and apply it if it does, or move to the next command if it does not. On this slide, the dark blue selected in the Theme Colors menu is showing in the corporation name. Prior to the selection of dark blue, the font color was red.
The contextual tab shows specialized commands that display only when the object they affect is selected. A selected picture produces a contextual tab with commands specifically related to the image, such as the Drawing Tools tab shown here. When you click away from the image, the contextual tab disappears
Keyboard Shortcuts
[image: keyboard shortcuts]
Key Tips are numbers or letters that can be used as keyboard commands to access tabs on the Ribbon. To access the Key Tips, press the Alt key. Then press the key for the tab you wish to open. There are even Key Tips for opening the Office Button! Using Key Tips is easy because you don’t have to remember the shortcut keystrokes. If you are used to using Ctrl keystrokes from previous versions of Office, those will still work.
The Status Bar
[image: status bar]
The status bar provides specific information about the file on which you are working. It is located at the bottom of the window. In this PowerPoint status bar, you can see circled, the slide number, the total number of slides and the applied theme. The View commands provide quick access to the various views available for the application. A Zoom slider allows you to change the magnification of the document. Slide it to the right and the document increases in size. Slide it to the left and it decreases in size. Bear in mind that different Office 2007 applications may display different information on the status bar.

Office 2007 Help
[image: office 2007 help]
You are never far away from getting help when using Office 2007 and that help can be accessed in a variety of ways. There are help files on your computer that were installed as the software was installed. Microsoft Office Online offers more help files, plus access to new products and files such as templates and graphics to help you complete your projects.
Initiating help can be done by using either the Help button on the Ribbon or the keyboard F1 key. This will open a dialog box with a search option, a list of topics and the ability to view help through a table of contents.
Super ToolTip Help
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Super ToolTips are displayed when the mouse lingers over a command on the Ribbon. The Super ToolTip provides the command name, a brief description of the command and a link for additional help. If you would like even more help, hold the mouse on the command and press F1. This will take you directly to the help file for this command because Super ToolTips are context sensitive.
Information on obtaining help with dialog boxes follows on the next slide.
Dialog Box Help
[image: dialog box help]
Sometimes you need help in dealing with a dialog box, but you don’t want to close the dialog box to get assistance. Each dialog box contains a Help button located on the title bar for the dialog box. If you select a dialog box Help button, the help will be context sensitive and apply to the open dialog box.
This concludes our discussion of getting help in Office 2007, but it shouldn’t be the last time you use it or think of it. Whenever a question arises, be sure to check out Help first!
Universal Tasks
	Manipulating files
· Creating new files
· Opening files
· Saving files
· Printing files
	Manipulating documents
· Editing documents
· Formatting documents


 
Throughout Microsoft Office 2007 there are tasks that you will need to complete in all of the applications. Two broad categories of universal tasks are manipulating files and manipulating documents. We will cover each of these task groups in detail, pointing out techniques used to complete tasks.
Computers are useful because they store data in files. The data can later be retrieved and formatted into reports. Computers can hold vast amounts of data but if it is to be useful, people need to be able to easily access and re-use the data. Our discussion of manipulating files focuses on opening, saving and printing the files. In the lesson on Windows XP, techniques for using folders were discussed. That will remain important because the files should be organized in a thoughtful way on your storage devices so you can find them faster. Also discussed in the lesson on Windows XP were techniques for copying, moving and deleting files. Such techniques are accomplished by using the operating system. The techniques we will discuss in the next few slides are accomplished by using the software.
Creating New Files
	Software
	 Default Filename

	 Word
	 Document1

	 PowerPoint
	 Presentation1

	 Excel
	 Book1


 
Whenever you work with a software application, you either need to open an existing file or start a new file. Microsoft Office creates a new file whenever the software is started. A default name is assigned to a file until you save it and designate a name for it. The default names are listed here because sooner or later you will probably be in a hurry and save a file to the default filename. It may appear as if you have lost your file, when in reality it has been stored. You can look for these filenames when you make this kind of mistake.

Finally, you do not want to use filenames like Document1, Document2 and Document3. Filenames should be descriptive. In some business environments, you will be required to name files using a very strict set of rules so that not only can you find them, but your co-workers can too.
Saving a File
[image: save file]
A good practice is to save the file with the descriptive name as soon as you open the software. As you work on a complex file, it is a good idea to save different versions of it with different names as you work on it. This way if you have a problem with the most recent file, you can always open the previous file and not have to start again from scratch.

To save a file in Word, Excel or PowerPoint, click the Office Button. Two options for saving will appear on the Office menu. Save is used if you wish to save the document with the original file name. Save As is used the first time a document is saved, if you wish to change the name of the document, or as a new file type preserving the original file with its original name. This slide shows the Save As dialog box because this is a new file being saved. How can you tell? There is no data in the file and the name on the title bar is Book1.
· The first thing you should do when you are working with this dialog box is to select the location in which the file will be saved. You may select a location from the My Places Bar. In this graphic, the My Documents folder has been selected. If you wish, you may also create a new folder. Since folders provide a hierarchical storage system, you may need to move up a folder to find the correct storage location.
· The second step in saving a file is to provide a descriptive filename.
· The third step is to check the Save As type to make sure that it fits your needs. Normally the textbox contains the regular file type for the software you are using, but it can be changed to fit other needs. For instance, a Word document can be saved as a document, document with macros, template, template with macros, and in other formats such as a web page.
 
After making appropriate selections, click the Save button and the file will be stored as you specified. If you have used Office software in the past, you will be familiar with the filename extensions added by the software. With the new version, Microsoft has introduced XML formats to make use of file compression to save storage space and to make it easier to open the files with other software. The extensions now contain four characters. The extra character describes whether the file contains macros, is a template, or has other characteristics.
My Places Bar
[image: myplaces bar]
While in the Save As menu, you can change the My Places Bar to reflect the folders you use most often in Word, Excel and PowerPoint. Select the folder you wish to put on the bar in the Save in box. In this slide, you can see that we are using the Excel 2007 folder. Point to the empty space in the My Places Bar and right-click. From the shortcut menu select the option to Add the folder. Notice that you can remove or rename the folder from the My Places Bar as well as move it to a different location on the bar. You will only be able to manipulate the folders you put on this bar. The other folders, assigned by the software, will remain unchanged.
Opening a File
[image: open file]
The Open command on the Office menu to is used to access a file on a storage device, bringing it into the memory of your computer so that you can work with it. Click the Office Button to see the Office menu.

In a similar fashion to saving a file, you must find the storage location of the file. The Look in box gives you access to the hierarchical view of the structure of folders and subfolders on your computer or network by clicking on the down arrow. You may also select the location from the My Places Bar. You may change the View of the folder list, navigate up, create new folders and delete files and folders using the Look in toolbar buttons.

When you have found the file you wish to open, select it and click the Open button. This loads the file into the software application.

There are instances where you may not want to open the file, but rather open it as read-only or as a copy. This will be discussed in the next slide.
Open Dialog Box
[image: open dialog box]
There are situations where you might not want to open a file directly for editing. You might be a part of a workgroup that shares files. In this situation, you will need some alternatives in opening the files so that you do not damage the original file you share.

To access the Open Dialog Box, click the down arrow on the Open button. As you can see, there are a variety of options. Open loads the file for editing. Open Read-Only will not allow you to make changes to the file. Open as Copy loads a copy of the file for editing, leaving the original file intact in the storage location. Open in Browser loads the file into a Web browser. Open and Repair attempts to repair any damage to the file and open it for editing.
Recent Documents List
[image: recent document list]
Office 2007 provides a quick method for accessing files you have used recently through the Recent Documents list. When you click on the Office Button, the Recent Documents list appears on the right side of the menu. If a file you wish to use is on the list, simply click on it to select and open it.

As the name implies, the files in the Recent Documents list change as you use other files. If you wish to keep a file on the Recent Documents list, you may pin it to the list. Click on the gray icon of the push pin to change the color to green. This means that the file will remain on the list permanently. If you later wish to remove it from the list, click on the push pin again. The pin will change back to gray and as other files are used on the system, this one will drop from the list.
Previewing a Document
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Hard copies of documents are needed for distribution. This might include letters, spreadsheets, handouts and other types of informational reports. Office 2007 provides many options for printing documents.

A powerful tool offered in Office is the option to preview documents prior to printing them. This saves paper and time. You can instantly see if something is not lined up correctly or if the orientation of the page is incorrect for your needs.

To access the Print Preview, click the Office Button and click on the arrow next to the Print command on the Office menu. Select the Print Preview option. The Print Preview tab becomes available with groups for making adjustments to the view or to the document. Note that in the Page Setup group, you can change the margins, orientation and size of the document. In the Zoom group, you have options to magnify the document, show it in actual size, and show multiple pages at one time. The Preview group allows you to move from one page to the next so that you can check the entire document before printing.

If you need to edit the document before printing, click the Close Print Preview button and make the necessary changes to the document. If you are satisfied with the document as it is shown, click on Print in the Print Preview tab. 
Print Dialog Box
[image: print dialog box]
Before exploring the Print dialog box, you should recall page orientation.
 
The orientation of the document on the page can be portrait or landscape. In the portrait orientation, the page is longer than it is wide. In landscape orientation, the page is wider than it is long. You can change the orientation of the page in the Print Preview Page Setup group.

You can access the Print dialog box from the Print Preview view, or you can select it directly from the Office menu. The Print dialog box provides many options for printing a document. Each time you print a document you should check the settings for the printer, what to print, and how to print.

The printer selection will be set to your default printer when you open this dialog box. It can be changed by clicking the down arrow in the printer name box. You would do this if you had multiple printers available and wanted to select another.

In the Print range area, you can select to print the entire document, just the current page shown in the window, or set a range of pages to be printed.

In the Print what area, the options will be different depending on the software application you are using. In the PowerPoint application, you will have options to print slides, handouts, notes or an outline. In this Word example, you will see the option of printing the document. Other choices under the down arrow include document properties, styles, markups, and more.

In the Copies area of the dialog box, you select the number of copies you wish to print using the spin box. NOTE: You may have a duplex printer which prints on both sides of the paper. If you do not have this type of printer, you can create the same effect by selecting the Manual duplex check box. The document will print all of the odd numbered pages first, then prompt you to flip the pages over and put them back in the printer tray. It will then print all of the even numbered pages.
Quick Printing
[image: quick printing]
You do not have to use a dialog box for printing. A Quick Print option sends the entire current file to the default printer when you select Quick Print from the Office menu or add a Print icon to your Quick Access toolbar.
To add the Print icon to your Quick Access toolbar, click on the Dialog Box Launcher of the Quick Access toolbar. Select the Quick Print option from the File menu on the left. Click the Add button in the middle. The Quick Print option then appears on the Quick Access toolbar. You can remove items from the right side by selecting the item and clicking the Remove button. You may also change the order that the icons are in on the Quick Access toolbar by clicking the up or down arrow on the right.
Basic Tasks
	Editing Documents
	Formatting Documents

	· Selecting
· Inserting
· Overtype
· Moving
· Copying
· Clipboard
· Finding
· Replacing
	· Go to
· Undo
· Repeat
· Spelling
· Grammar
· Thesaurus
· Research
	· Font
· Format Painter


In the previous slides, we discussed methods for manipulating files. The following slides will focus on the basic tasks that are similar as you manipulate the document. These tasks fall into two categories: editing the document and formatting the document.
Most of us, when creating a document, make mistakes. Office 2007 offers many options for making corrections. You may add text, delete text, and move text many times during the revision stage of your writing. We will discuss these actions in the next few slides. Office also contains tools to help you make your writing more accurate. Spelling and grammar can be checked as you are creating the document or after you have completed the draft. The Thesaurus can list synonyms if you find yourself using the same words over and over. The Research tool provides you with access to an online dictionary, encyclopedia, and other reference resources.
We will conclude our discussion with information on formatting documents to change their appearance. 
Selecting Text 
[image: select text]
Most editing processes require that you select the text you wish to edit. This is most often done by clicking and dragging over the text with the mouse. Selected text, as shown here, appears on a blue highlighted background. A new feature of Office 2007 is the Mini toolbar, which appears automatically when you select text in Word, Excel or PowerPoint. The Mini toolbar contains commands that apply to the selected text. These commands are normally found on the Home tab, but the Mini toolbar makes it quick to select an option. Note that the icons on the toolbar mimic the icons on the Home tab.
There are additional ways to select text, as detailed on the next slide.
Selecting Text (Cont'd)
[image: select text continued]
You can select text by other methods that may work better based on the what you are trying to select. If you wish to select a single word, you can double-click on it with the mouse. For a whole line of text, move the pointer to the left of the line and click when the mouse pointer changes to a right-pointing arrow. To select a sentence, hold the Ctrl key and click on the sentence you wish to select. If you wish to select an entire paragraph, triple-click the mouse in the paragraph. To select a character to the right or the left of the insertion point, hold the Shift key and press the arrow keys to the right or the left.

If you wish to select a large amount of text, click an insertion point at the beginning of the text, move to the end of the text that you wish to select, and holding Shift, click at the end of the text. This is very helpful when you want to select text that fills more than one page.
Insert or Overtype
[image: insert overtype]
By default, Office applications are set to insert text into the document as the text is typed. If you forgot a word in the middle of a sentence, click an insertion point where the word is to begin and type it. The text will insert and the rest of the text will slide to the right as you type.

You may also have situations where the text that is in the document must be replaced with other text. Using the Overtype Mode replaces the text to the right as you type the new text. To change to the Overtype Mode, open the Office menu and select the Word Option button. Select the option Use Overtype Mode in the Editing section of the Advanced tab. When you have completed your changes using the Overtype Mode, repeat these directions to remove the setting from the Word Options.

There is also a keyboard selection that you can make to control whether you are in Insert or Overtype Mode. It is a toggle, meaning the first time it is pressed it has one setting and the next time it changes to the other. In order to use the Insert key, a selection must be made on the Word Options dialog box shown here. Select the option Use the Insert Key to Control Overtype Mode. This stays in effect until you change the setting in this dialog box.
Moving and Copying
[image: move copy]
At times, you will decide that text you have in one place in your document would be better in another. The Clipboard commands make it easy to move text. At other times, you might decide to have the same text in multiple places in the document. Again, the Clipboard commands will assist you in copying the text.

The three Clipboard commands are Cut, Copy and Paste. Begin by selecting the text that will be affected by a move or copying. The Cut command, with a scissors icon, removes the text from its original location and stores it in memory. The Copy command, with a two-paper icon, makes a duplicate of the text and places it in memory. Click on the Cut or Copy icon. Click an insertion point where you wish to place the text, and paste it by clicking on the Paste command. Only one item can be stored in memory at a time.

When the text is pasted into its new location, a Paste Options button appears with the pasted text. By clicking the down arrow, you can select the formatting option for the text you pasted.

There are alternative methods for copying, cutting and pasting. After you have selected the text, point to it with the mouse and right-click. Select Copy or Cut from the shortcut menu. Move to the new location for the text, click on an insertion point, right-click the mouse again and select Paste from the shortcut menu.

Keyboard commands can also be used to copy, cut and paste. Press the Ctrl key and C to copy text. Press the Ctrl key and X to cut the text. Press Ctrl and V to paste.

Another way to move text is to drag and drop it into the new location with the mouse. This works if you are moving the text short distances.
The Clipboard
[image: clipboard]
A nice feature of Office 2007 is the ability to store multiple clips of text on the Clipboard. This memory location stores up to 24 items to paste in the current file, another file, or in another Office 2007 software application. To add items to the Clipboard, you must display it by clicking the Dialog Box Launcher in the Clipboard group of the Home tab. The Clipboard pane opens and the Clipboard collects items that you either copy or cut from your document.

To paste an item, place an insertion point in the document, click the item in the Clipboard pane to display the down arrow and then select Paste.

You may also set the Clipboard so it accumulates text clips without the Clipboard pane open. Click the Option button in the Clipboard pane and select the Collect without Showing Office Clipboard option.
Find Command
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Finding a particular word or phrase in a lengthy document can be time-consuming and frustrating. Office has three commands that can assist you with finding text. The Editing group on the Home tab contains the Find and Replace commands. Type the word or phrase into the Find what text box and click the Find Next button. You can continue to work through the document using the Find Next button.
Find and Replace Command
[image: find replace command]
Another handy feature is the ability to replace text that is found with new text. Let’s say you used your co-worker’s name in a document multiple times. Over the weekend, she flies to Vegas and gets married. To change her name in the document, you would use the Replace option. You type the original text into the Find text box on the Find and Replace dialog box. Type the new text into the Replace with text box and select the Replace, Replace Next or Replace All button.
Go To Command
[image: go to command]
In a long document you will often need to move to a specific page. Perhaps your co-worker tells you that a paragraph on page 25 needs to be changed. You can jump to that page in the document by using the Go To command. Type the number of the page you wish to locate and click Next. Note the additional options shown in the Go To dialog box.
Undo and Repeat
[image: undo repeat]
As you edit your Office files, you may find that you make a mistake or change your mind. The Undo option cancels your previous action and can continue canceling back multiple steps. The Undo button is located on the Quick Access Toolbar. The down arrow next to the command will list your previous steps. By selecting one of the listed steps, you can undo all of your actions up to that point.

The Repeat command is more limited. It will only repeat the last action.
Language Tools
[image: language tools]
Office 2007 contains language tools which assist you in spelling, grammar and research. Spelling and grammar are checked automatically as you work on a document. If a word in your document does not appear in the Office dictionary, it is flagged by a red wavy line. Grammatical errors are highlighted with a green wavy line. Please realize that these are suggestions or flags alerting you to possible problems. Words that are flagged may actually be right, with some examples being company names and proper names. These types of words can be added to the dictionary if they are used frequently so that they do not show up as incorrect.

To fix spelling errors, right-click on the word with a red wavy line. A shortcut menu will display possible spellings for the word. You will also see options to Ignore the misspelling once, Ignore all instances of the misspelling in the document, or Add to Dictionary. Grammatical errors display a similar shortcut menu, prompting you with options to improve the sentence.

You may also ignore all errors until after you have completed your document and check the entire document at once. The Proofing group on the Review tab offers the option for Spelling and Grammar checking.

Note that this verification process should not be the only way your document is proofread. You still have to proofread it carefully. Office does not read the text in context, so if you spell an incorrect word in the context correctly, it will not mark it.

Another language tool that is available in Office is a Thesaurus. This tool will help you select different words for those you find you are using too often. Select a word in the document to look up in the Thesaurus and right-click it. Select Thesaurus from the shortcut menu. The Thesaurus pane will open, offering you suggestions for alternative words. You may select one of those words or look up additional options.
Research
[image: research]
As you work with Word, Excel or PowerPoint, you may need to complete some quick research. Tools for completing this research are located in the Review tab under the Research option. The Research pane allows you to specify where to search, and includes tools such as a dictionary, encyclopedia, or Internet sites for business and financial information. Enter a search term or keyword into the text box in the pane and click on the Go button. Do not forget that information that you find using the Research pane is copyrighted. Avoid the problem of plagiarism by citing all sources that you use.
Font Attributes
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To improve the look of your documents, you will want to make changes to the fonts. This increases the visual appeal and lets you draw attention to important parts of the document.

Text can be formatted with font attributes such as font face, size, emphasis, and color. The Font group on the Home tab provides the formatting options. You have the choice of selecting the options and then typing the text, or typing the text, selecting it, and applying the options. More than one attribute can be applied to text, so you may have Times Roman font face, in size 26 point, in bold and italic, and colored blue. As you look at the Font group, you can tell what attribute is selected because it has a gold background. If you do not want it to be applied to the text, click on the attribute to unselect it. 

Office 2007 features Live Preview of font attributes. Select the text, point to the attribute on the Font group, and the text in the document will change to reflect the attribute you are pointing to. This helps you to make your selection quickly.

Changing font attributes is such a common task in Office 2007 that there are numerous places for you to change the font. You can use the Font group on the Home tab, the Mini toolbar that appears when you select text, and the Font dialog box available by clicking on the Dialog Box Launcher. When using the dialog box, you will not have the benefit of Live Preview, but you may select multiple formatting options quickly. The preview will appear instead in the Preview box of the dialog box.
The Format Painter
[image: format painter]
After you have formatted the text in one part of your document, you may want to use the same formatting in other parts of the document. Rather than remembering what each attribute was set to, you may use the Format Painter to “paint the format” onto the text.

First, select the formatted text. Second, click on the Format Painter in the Clipboard group of the Home Ribbon. If you single-click, the format will be applied to only one location, turning off after you have applied it. If you want to apply the format to multiple locations in the document, double-click the Format Painter command. Once the Format Painter has been loaded with the format, click and drag across the text you wish to format. If you double-clicked on the Format Painter, press the Esc key to turn the function off.
Study Questions
· What is the purpose of the Ribbon? Where is it located?
· What is the Office Button?  What commands are located in it?
· What is the Quick Access Toolbar?
 
Objectives Achieved
· Identify common interface components
· Use Office 2007 help
· Open a file
· Save a file
· Print a document
· Select text to edit
· Edit text in the insert and overtype modes
· Move and copy text
· Find, replace, and go to text
· Undo and Redo
· Use language tools
· Apply font attributes
· Copy formats with Format Painter
 
	1. Software that is used primarily with text to create, edit, and format documents is known as:

	a)
	Electronic spreadsheet software

	b)
	Word processing software

	c)
	Presentation graphics software

	d)
	Relational database software

	2. Which Office feature displays when you rest the mouse pointer on a command?

	a)
	The Ribbon

	b)
	The status bar

	c)
	An Enhanced ScreenTip

	d)
	A dialog box

	3. What is the name of the blinking vertical line in a document that designates the current location in the document?

	a)
	A command

	b)
	Overtype mode

	c)
	Insert mode

	d)
	Insertion point

	4. If you wanted to locate every instance of text in a document and have it temporarily highlighted, which command would you use?

	a)
	Find

	b)
	Replace

	c)
	Go To

	d)
	Spell Check

	5. The meeting point between computer software and the person using it is known as:

	a)
	A file

	b)
	Software

	c)
	A template

	d)
	An interface

	6. Which of the following is true about the Office Ribbon?

	a)
	The Ribbon displays at the bottom of the screen.

	b)
	The Ribbon is only available in the Word 2007 application.

	c)
	The Ribbon is the main component of the Office 2007 interface.

	d)
	The Ribbon can’t be used for selecting commands.

	7. Which element of the Ribbon looks like folder tabs and provides commands that are task-oriented?

	a)
	Groups

	b)
	Tabs

	c)
	Status bar

	d)
	Galleries

	8. Which Office 2007 element provides commands that work with an entire document or file and displays by default in the title bar?

	a)
	Galleries

	b)
	Ribbon

	c)
	Office Button

	d)
	Groups

	9. If you needed the entire screen to read a document, which document view would you use?

	a)
	Outline view

	b)
	Draft view

	c)
	Print Layout

	d)
	Full Screen Reading

	10. The default four-letter extension for Word documents that do not contain macros is:

	a)
	.docx

	b)
	.pptx

	c)
	.xlsx

	d)
	.dotm

	11. Before you can cut or copy text, you must first do which one of the following?

	a)
	Preview the document

	b)
	Save the document

	c)
	Select the text

	d)
	Undo the previous command

	12. What is the name of the memory location that holds up to twenty-four items for you to paste into the current document, another document, or another application?

	a)
	My Places bar

	b)
	My Documents

	c)
	Ribbon

	d)
	Clipboard

	13. Word flags misspelled words by marking them with which one of the following?

	a)
	A green wavy underline

	b)
	Boldfacing them

	c)
	A red wavy underline

	d)
	A double-underline in black

	14. Which of the following displays when you select text in a document?

	a)
	The Mini toolbar

	b)
	The Quick Access Toolbar

	c)
	A shortcut menu

	d)
	The Ribbon

	15. Formatting text allows you to change which of the following text attributes?

	a)
	The font

	b)
	The font size

	c)
	The font type

	d)
	All of the above
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